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C H A P T E R 1
Introduction to the Cisco Business Edition 6000
and 7000 appliances

• Who Should Use This Guide?, on page 1
• Essential Documents for Installation of the Business Edition 6000 or 7000 Appliance, on page 2

Who Should Use This Guide?
This guide is for deployments using the BE6000M (M6) BE7000M (M6) or BE7000H (M6) appliance models,
factory-preloaded with the 12X14X-K9-15 or 12X14X-XU-15 applications suite for Collaboration System
Releases 12.7 and higher, and 14.

This guide helps you set up your Business Edition appliance if you can answer yes to the following questions.

• Are you doing a manual installation of applications on a Cisco Business Edition appliance? This guide
covers everything that you have to do to customize it for your business needs.

Are you installing application versions from Collaboration System Release 12.7, 14 or later? If yes, this
installation guide applies. If no, then your applications may not support ESXi 7.0 and you cannot leverage
the factory-loaded software.

Applications from Collaboration System Releases 12.0, 11.x and older are not factory-installed on M6
appliances.

• Does your deployment fit within the Supported Solution Capacities described in Appendix A?

Cisco partners can find more information on the http://www.cisco.com/go/bepartner.Note

Do not reinstall or downgrade the factory-loaded virtualization software. Do not reformat the disks or
rebuild the storage hardware array. Either action wipes out the factory preloaded software and causes
post installation licensing problems.

Caution

Business Edition 6000 and 7000 Appliances are shown in following:
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Figure 1: Business Edition 6000 and 7000 Appliances

Essential Documents for Installation of the Business Edition
6000 or 7000 Appliance

You can proceed with the installation by using the instructions in this document, refer the following documents
that are listed for Deployment Options, Equipment, and Applications. All of these documents are available
at the http://www.cisco.com/c/en/us/support/unified-communications/business-edition-6000/
tsd-products-support-series-home.html

Choose the product version, and then refer to the following documents:

• Deployment Options—To gain insights to help you plan your deployment, see the Preferred Architecture
guides and the Cisco Validated Designs that are relevant to your business needs.

• Applications—To find out more about applications, see the following documents:

• Business Edition 6000/7000 Software Load Summary / Release Notes—This document contains
information on ISO and OVA files that are pre-loaded in the appliance's datastore.

• Other documents for UC applications are listed on the Component Documentation tab.
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C H A P T E R 2
Installation of Cisco Business Edition 6000 or
7000 appliance

• Design Your Deployment, on page 3
• Set Up Your Appliance, on page 5
• Set Up Your Applications, on page 14

Design Your Deployment
Review the following topics to design your deployment.

Plan Your UC Applications
Before You Begin:

Before you unpack the server, verify that all of the following items are present. If any of the item is missing
or appears to be damaged, contact your supplier immediately.

• Cisco Business Edition 6000 or 7000 appliance

• Rack-mounting kit

• Power cord(s)

• Any other required cables (not included with appliance, such as KVM adapter, Ethernet cable, Console
cable).

Ensure that you have the following before you unpack the server:

• Space in a standard 19-inch equipment rack (1RU for each BE6000 appliance or 2RU for each BE7000
appliance).

• 110 / 220 VAC power feeds.

• VGA monitor and USB keyboard (not supplied) – for initial installation only.

• Ethernet network port(s) configured for appliance's local area network access.

For More Instructions:
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• To understand the BE6000 appliance's front and rear panels, see the Detailed Views chapter of the Spec
Sheet for Cisco UCS C220 M6 SFF Rack Server (M6S chassis).

• To understand the BE7000 appliance's front and rear panels, see the Detailed Views chapter of the Spec
Sheet for Cisco UCS C240 M6 SFF Rack Server (M6SX chassis).

• To rack-mount a BE6000 appliance, see the rack-mount instructions in the Cisco UCS C220 M6 Server
Installation and Service Guide.

• To rack-mount a BE7K appliance, see the rack-mount instructions in the Cisco UCS C240 M6 Server
Installation and Service Guide.

Make sure that your Cisco Business Edition 6000 or 7000 appliance is rack-mounted and connected to power
and data networks.

Before you begin any installation, plan which UC applications you are going to install. For information on
the UC applications that are available for installation, and on how to design your Business Edition collaboration
deployment refer to the following sites:

• Unified Communications in a Virtualized Environment—This website contains information on the Cisco
virtualized applications that are available for installation on a Cisco Business Edition 6000 or 7000
appliance, and how to design your deployment.

http://www.cisco.com/go/virtualized-collaboration

• Infrastructure & Co-residency requirements —This web page contains information on the conditions
that you must meet to run Cisco applications and any third-party applications on a Business Edition
6000/7000 appliance

https://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/uc_system/virtualization/
cisco-collaboration-infrastructure.html

• Preferred Architecture Guides —Preferred Architecture documents and CVD guides offer prescriptive,
end-to-end system solutions for Collaboration and Voice deployment. The design overviews provide a
basic understanding of the products and their roles in the Preferred Architectures, including high-level
best practices. The CVD guides provide more detailed design and deployment recommendations that
help streamline the implementation of Preferred Architectures.

http://www.cisco.com/go/pa

• Midmarket Collaboration CVD Guides—Midmarket CVDs provide detailed design and step-by-step
deployment information for collaboration solutions that are built on the Cisco Business Edition 6000/7000.
These CVDs are based on the core recommendations of the Preferred Architectures, and in sometimes,
they offer more solution designs as extensions or alternatives to the Preferred Architectures.

http://www.cisco.com/go/pa

• Business Edition 6000/7000 Software Load Summary/Release Notes—Preload Summary documents
provide information on ISO and OVA files that are pre-loaded in your server's datastore.

https://www.cisco.com/c/en/us/support/unified-communications/business-edition-6000/
products-release-notes-list.html

https://www.cisco.com/c/en/us/support/unified-communications/business-edition-7000/
products-release-notes-list.html
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Collect Required Network Information
Collect the following network settings for your installation:

• Subnet mask

• Gateway IP Address

• VMware vSphere ESXi IP address

• VMware vSphere ESXi management IP address

• Cisco Integrated Management Controller (CIMC) IP address

• UC application IP addresses

• DNS server IP address

• UC application hostnames

• (Optional) Domain name

• NTP server IP address

• Time zone

• (Optional) SMTP server

Decide how you will interconnect the appliance to your network. Specifics on network interconnection options
are beyond the scope of this guide, but below are some important callouts.

Available physical ethernet ports depend on the appliance model:

• All M6 appliance models include modular LAN on motherboard ports as described in the Cisco UCS
C220/C240 M6 Rack Server (Small Form Factor Disk Drive Model) Spec Sheet.

• BE7K M6 appliance models ship with quad port 10-Gigabit Ethernet network interface cards. It is not
supported on any appliance model to add network interface cards, add virtual interface cards, or change
included network interface card.

Set Up Your Appliance
Review the following topics before you begin your installation.

Installation of Virtualization and Application Software
This section describes the tasks that you must perform to install virtualization and application software on
your Business Edition 6000 or 7000, using the factory preload.

Preloaded File Types in the Datastore
In addition to pre-deployed virtual machines, Cisco Business Edition appliances are shipped with selected
Collaboration application software that is pre-loaded on the datastore. Following is a breakdown of the file
types for application installs:

Installation Guide for Cisco Business Edition 6000 and 7000, Release 14 (M6 Appliances, preloads 12X14X-K9-15 / 12X14X-XU-15)
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• ISO Files—An ISO file is a DVD image containing application install files (for example,
Bootable_UCSInstall_UCOS_12.5.1.10000-22.sgn.iso).

An ISO file is present for a UC application only if the OVA file for that application does not include the
application software.

• OVA Files—Each UC application has an associated Open Virtualization Archive (OVA) file, which is
used to package and deploy the virtual machine. There are two types of OVAs for Business Edition
servers:

• SomeOVAs (e.g. cucm_12.5_vmv13_v1.0.ova) are templates that define the VM, but do not include
any application software. For those applications, there is an associated ISO file in the datastore (for
example, Bootable_UCSInstall_UCOS_12.5.1.10000-22.sgn.iso). For the installation, you must
deploy the OVA template and install the software using the associated ISO file.

• Other OVA files define the VM and include the application software (for example,
Bootable-CiscoPagingServer_12.5.1.ova). For these applications, there is no ISO
file. You can deploy the VM and install the software using the OVA file.

For information on which ISO and OVA files are pre-loaded in your server's datastore, refer to the preload
summary for your server at the http://www.cisco.com/c/en/us/support/unified-communications/
business-edition-6000/products-release-notes-list.html or https://www.cisco.com/c/en/us/support/
unified-communications/business-edition-7000/products-release-notes-list.html.

Cisco recommends that you archive the OVA-ISO directory locally. If there is a hardware failure,
replacement hardware does not include a factory preload. If the factory preloaded software is either
deleted, overwritten, or lost, then manual rebuild of preloaded software is required. Restore to the factory
default capability is not supported.

Note

Installation Task Flow of the Cisco Business Edition 6000/7000
Perform the following tasks to install software on your Cisco Business Edition 6000/7000 server.

Procedure

PurposeCommand or Action

Configure CIMC for your Business Edition 6000 server.Configure Cisco Integrated Management Controller, on
page 6

Step 1

Configure the pre installed VMware vSphere ESXi software
on the appliance.

Customize Virtualization Software Remote Access, on page
9Customize Virtualization Software Remote Access

Step 2

Delete any pre deployed VMs that you do not require.Delete Unused or Unwanted Virtual Machines, on page 13Step 3

Configure Cisco Integrated Management Controller
Cisco Integrated Management Controller (CIMC) is the management interface for the Cisco UCS appliance.
CIMC runs within the appliance, allowing remote administration, configuration, andmonitoring of the appliance
through web or SSH command-line access.
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Complete the following tasks to configure CIMC on a Business Edition 6000 or 7000 appliance deployments.

Complete the following tasks to Configure Cisco Integrated Management Controller:

Procedure

PurposeCommand or Action

Power on and Initial CIMC Setup, on page 7Step 1

Complete the CIMC Configuration, on page 8Step 2

Power on and Initial CIMC Setup

Use this procedure to power on the appliance and begin the basic Cisco Integrated Management controller
(CIMC) configuration.

Before you begin

Ensure that the Business Edition 6000 or 7000 appliance has been rack-mounted, connected to a power supply,
connected to the data network, and that a monitor and keyboard are connected to the appliance.

Step 1 Verify that power is connected and that the power button LED is orange.
Step 2 Push the appliance power button and verify that it changes to green.
Step 3 Watch the boot process on the monitor.
Step 4 When the blue Cisco logo appears, press F8 to enter the CIMC configuration dialog. Appearance of this screen may vary

with appliance model and firmware version.

Figure 2: Press F8 at the CIMC Boot Screen

Step 5 When prompted, enter the username admin and create a new password.
Step 6 On the CIMC configuration screen, complete the following details:

• CIMC IP address
• Subnet mask
• Gateway IP address

Installation Guide for Cisco Business Edition 6000 and 7000, Release 14 (M6 Appliances, preloads 12X14X-K9-15 / 12X14X-XU-15)
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Figure 3: Enter the CIMC IP Address Details

Step 7 When complete, press F10 to save your changes and boot the system.

Complete the CIMC Configuration

Use this procedure to configure DNS and NTP settings in the CIMC interface.

Before you begin

Power on the appliance and begin basic Cisco Integrated Management Controller(CIMC) configuration.

Step 1 In a web browser, enter the CIMC IP address and log in with the username admin and the password that you created in
the previous task.

Step 2 From the left menu, select the Admin tab, and click Network.
Step 3 In the home page, select the Network Settings tab.
Step 4 From Common Properties, change the Hostname setting to the CIMC hostname.
Step 5 From IPv4 Properties, change Preferred DNS Server to the IP address that you have specified for the DNS server.
Step 6 In the home page, select the NTP Settings tab.
Step 7 Check the Enable NTP check box.
Step 8 In the Server 1 field, enter the NTP server IP address.
Step 9 Select Save Changes from the bottom right corner of the page.

Configure Virtualization Software
Complete the following tasks to set up the VMware vSphere ESXi:

Installation Guide for Cisco Business Edition 6000 and 7000, Release 14 (M6 Appliances, preloads 12X14X-K9-15 / 12X14X-XU-15)
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Before you begin

Make sure you have obtained a license for VMware vSphere ESXi for your appliance. A license is required,
but is not included with or factory preloaded on M6 appliances.

Procedure

PurposeCommand or Action

Customize VMware vSphere ESXi Remote Access.Step 1

Access and Configure the VMware vSphere ESXi.Step 2

Customize Virtualization Software Remote Access

Follow this procedure to customize the VMware vSphere ESXi to enable remote access from your PC using
the VMware Embedded Host Client.

Step 1 When the hypervisor boots, the ESXi Direct Console User Interface displays on the monitor as shown in the following
figure "(appearance of this screen may vary by appliance model and preloaded software version)".

Figure 4: Console Screen After ESXi Loads
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Step 2 Press F2 to enter the System Customization menu as shown in the following figure.

Figure 5: ESXi System Customization Menu

The default username is root and default password is c!SCo123.

Step 3 After logging in, you must change the default password, choose Configure Password to change the password.

If your applications are pre-deployed, skip to Step 5, on page 11.

Step 4 To assign a static IP address, select the Configure Management Network menu, and follow the instructions on screen
to change “IP Configuration”.
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Figure 6: Assign Static IP Address to ESXi Host

Step 5 Connect your PC to the data network, and browse to the new hypervisor IP address.

Figure 7: Hypervisor Welcome Page

Access and Configure Virtualization Software

Some Business Edition applications require the host to have a valid time reference. Follow these steps to
access the ESXi host to configure NTP and configure fault tolerance for network interface cards (NICs) using
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the NIC teaming feature, view preinstalled applications, and browse the datastore to verify the preloaded
collaboration application software.

Before you begin

Customize Virtualization Software Remote Access, on page 9

Step 1 Browse to the “https://[ESXI-HOST-IP-Address]/ui/” to access VMware Embedded Host Client.

Figure 8: Access Virtualization Software Using VMware Embedded Host Client

Step 2 Use the login credentials that you previously configured.
Step 3 If selected at time of quoting, BE6000 and BE7000 appliances are factory loaded with unlicensed ESXi 7.0 U1 and vmfs6.

A license for ESXi is required. This license is always sold separately from the M6 appliance and is not included with,
sold with or factory loaded onM6 appliances. On power up ESXi will enter its time-limited evaluationmode. After expiry
of evaluation mode, virtual machines will not be able to power up. If you want to re upload or version-upgrade this license,
follow these steps:
a) Locate your license document that has the license serial number you will use on the appliance.
b) Navigate to Manage > License > Assign License.
c) Type in or copy or paste the license serial number from the license document.
d) Click Check License to validate the license key.

Step 4 Configure NTP settings:
a) Navigate to Manage > System > Time & date.
b) Click Edit settings to launch the Edit time configuration screen.
c) Check Manually configure the date and time on this host check box.
d) Update the Time.
e) Check the Use Network Time Protocol (enable NTP client) check box.
f) Select Start and stop with host from NTP service startup policy drop-down.
g) Type the IP address of NTP server in NTP servers. If you want to add multiple NTP servers, type the IP address of

NTP servers that are separated by commas.
h) Click Save.

Step 5 (Optional) Configure fault tolerance by using the NIC teaming feature in VMware:
a) Navigate to the Networking > Management Network.
b) Click Edit settings to launch Edit port group- Management Network.
c) In the Edit port group- Management Network screen, enter the name, VLANID, Virtual switch.
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d) Expand NIC teaming, enter the required details.
e) Click Save to add the NIC that is connected to the data network.

By default, only one NIC is enabled for the hypervisor and identified as vmnic0.Note

Step 6 Browse the datastore:
a) Navigate to Storage > Datastore to list the datastores in the Business Edition appliance.
b) Select datastore1.
c) Click the Datastore browser. You can view the Preloaded Collaboration Virtual Machines and preloaded software.

Figure 9: Browse Datastore to View Preloaded Collaboration Virtual Machines and Preloaded Software

Step 7 (Optional) Cisco recommends that you archive the OVA-ISO directory locally. If fails, the replacement hardware does
not include preloaded content.

Delete Unused or Unwanted Virtual Machines
You can optionally delete unused or unwanted preloaded files to free up disk space or make room for subsequent
installations in the following scenarios:

• If you want to deploy a new application version or patch level than the existing factory-preloaded
application.

• If you do not want to run a particular preloaded application and its files.

Step 1 Log in to VMware Embedded Host Client.
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Figure 10: Delete Any VMs That You Are Not Using

Step 2 Expand Virtual Machines and locate the virtual machine that you want to delete.
Step 3 If the VM has a green triangle, right-click the icon and select Power > Power Off.

The green arrow disappears as the VM powers off.
Step 4 Right-click the VM and select Delete.
Step 5 Repeat this procedure for each virtual machine that you wish to remove.

Set Up Your Applications
Perform the following tasks to set up your applications on the Cisco Business Edition 6000/7000 appliance.

Procedure

PurposeCommand or Action

Deploy virtual machine OVAs for each UC application that
you want to install.

Deploy Virtual Machine OVAs, on page 15Step 1

If your Business Edition 6000/7000 deployment includes
Cisco Unity Connection, customize the Unity Connection
VM.

Customize Virtual Machines for Cisco Unity Connection,
on page 16

Step 2

For UC application installations that require an ISO file,
mount the ISO file on the application VM.

Associate Application ISO Files to Virtual Machines, on
page 16

Step 3

For a list of applications that use ISO installation
files, see the Pre-Load Summary for your
appliance.

Note
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PurposeCommand or Action

Optional. Use touchless installation to install any of the
following core UC applications:

Install UC Applications Using Touchless Installation, on
page 17

Step 4

• Cisco Unified Communications Manager

• IM and Presence Service

• Cisco Unity Connection

• Cisco Unified Contact Center Express

If you prefer, you can use manual installation
for these applications.

Note

Use the manual interactive process to install any remaining
UC applications.

Install UC Applications Manually, on page 21Step 5

Deploy Virtual Machine OVAs
For each application that you want to run, requires one of the preloaded virtual machine OVA files. If a new
version is preferred, then it is recommended to delete the existing version.

Depending on the preloaded application, the OVA contains any of the following applications:

• Fully installed ready to run application

• Partially installed application

• VM configuration alone for an empty virtual machine

For more details, see the Preload File Summaries in Release Notes at the http://www.cisco.com/c/en/us/support/
unified-communications/business-edition-6000/products-release-notes-list.html.

http://www.cisco.com/c/en/us/support/unified-communications/business-edition-7000/
products-release-notes-list.html

The base OVA template files that contain empty virtual machines are deployed in seconds, while larger
OVA files that contain partially or fully installed applications can take longer to deploy.

Note

If you rebuild your appliance to use ESXi 6x, then ensure proper operation of your appliance and any
embedded virtualization licenses, ensure it is running ESXi 7.0 U1 or greater, with the Cisco UCS-specific
image of ESXi.

Caution

Step 1 On the VMware Embedded Host Client, navigate to the Virtual Machines.
Step 2 Right-click the Virtual machines and select the Create/Register VM.
Step 3 Select Deploy a virtual machine from an OVF or OVA file as select creation type.
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Step 4 Specify a meaningful name for the virtual machine.
Step 5 Browse and select the source OVA template file on your PC. For application and filename mapping, see the Build

Summary PDF in the datastore OVA-ISO directory, or download from here: http://www.cisco.com/c/en/us/support/
unified-communications/business-edition-6000/products-release-notes-list.html or http://www.cisco.com/c/en/us/support/
unified-communications/business-edition-7000/products-release-notes-list.html.

Step 6 Select the datastore in which to store the configuration and disk files.
Step 7 Select the deployment options.
Step 8 If prompted to accept license agreements, continue to click Next.
Step 9 Select the deployment options.
Step 10 If prompted for the Disk Format, specify Thick Provision Lazy Zero.
Step 11 Review your settings selection before finishing the wizard.
Step 12 Click Next.
Step 13 Deploy VMs for all your UC applications before proceeding to the next task.

If your system includes Cisco Unity Connection, then Customize Virtual Machines for Cisco Unity Connection.
Otherwise, Associate Application ISO Files to Virtual Machines.

Customize Virtual Machines for Cisco Unity Connection
For Customized installations, use this procedure to configure your Cisco Unity Connection virtual machine
settings to ensure optimum performance.

Preconfigure

Before you begin

For Customized installations, use this procedure to configure your Cisco Unity Connection virtual machine
settings to ensure optimum performance. Deploy Virtual Machine OVAs, on page 15

Step 1 On VMware Embedded Host Client, navigate to the Virtual Machines.
Step 2 Right click the Unity Connection entry and select Edit Settings.
Step 3 If you want to use the Unity Connection, or Unified, or Integrated Messaging, do the following:

a) Select the Virtual Hardware tab.
b) Select the CPU menu and set the number of Cores per Sockets to 2.
c) In the Reservation tab, increase the reservation to 3598MHz.

For more information, see the https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/connection/12x/supported_
platforms/b_12xcucspl.html.

Associate Application ISO Files to Virtual Machines
If you have deployed a skip-install OVA that contains any of the following partially installed applications,
skip this step.
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• Cisco Unified Communications Manager

• IM and Presence Service

• Cisco Unity Connection

• Cisco Unified Contact Center Express

• Cisco Emergency Responder

If you have deployed an OVA that contains ready to run fully installed applications, skip this step.

For all other OVA files that contain only VM configurations of empty virtual machines, use this procedure
to associate the ISO installation files that is used to complete the installation.

For an up to date list of installation files for your appliance, see the Preload Summary for your appliance
in the datastore OVA-ISO directory or at: http://www.cisco.com/c/en/us/support/unified-communications/
business-edition-6000/products-release-notes-list.html .

Note

Step 1 In the VMware Embedded Host Client, select the UC application virtual machine.
Step 2 Click Edit .
Step 3 From Virtual Hardware tab, select CD/DVD Drive 1.
Step 4 Select Datastore ISO File from CD/DVD Drive 1 drop-down list.
Step 5 Browse to the datastore and locate the application ISO file.
Step 6 Select the file and click Select.
Step 7 In CD/DVD Drive 1, check the Connect at power on check box under the Status.
Step 8 Repeat this procedure for each application that you want to install that includes an ISO file.

Install UC Applications Using Touchless Installation
Touchless installation allows you to install multiple UC applications and virtual machines of an application
simultaneously, across the different hosts if necessary, without having to interact with the system while the
install process runs. While you must prepare the system, touchless installation can save time, particularly if
you want to install multiple applications. If you are installing only one or two applications, you may prefer
to follow the manual procedure in the following section.

Use touchless installation to install the following applications:

• Cisco Unified Communications Manager

• IM and Presence Service

• Cisco Unity Connection

• Cisco Unified Contact Center Express

• Cisco Prime Collaboration Deployment
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Procedure

PurposeCommand or Action

Generate answer files (AFG files) for UC applications.Generate Answer Files, on page 18Step 1

Use your AFG files to create virtual floppy images.Create Virtual Floppy Images, on page 18Step 2

Upload your virtual floppy images to the datastore.Upload Virtual Floppy Images to Datastore, on page 19Step 3

Mount each virtual floppy on the corresponding UC
application VM.

Mount Virtual Floppy on Virtual Machines and Set Boot
Option, on page 19

Step 4

Run the touchless installation of your UC applications. We
recommend that you run your installations simultaneously.

Run Touchless Installation, on page 20Step 5

Generate Answer Files
Use this procedure to generate answer files for the touchless installation of your UC applications.

We recommend that you create application-specific folders (for example, UCM, IMP, CUC, CCX) in
which to save the generated files so that you do not get the files mixed up.

Tip

Step 1 Go to the online answer file generator at: www.cisco.com web cuc_afg .
Step 2 From the Product drop-down list, select the UC application for which you want to generate answer files.
Step 3 Select the Version that you want to install.
Step 4 Complete the remaining fields with the installation details that you want to configure on the appliance. For example, you

can assign items such as passwords, IP addressing, and DNS settings.
Step 5 Click Generate Answer Files to generate the platformConfig.xml file for that UC application.

Each UC application generates a platformConfig.xml file. Cisco Unified CommunicationsManager also generates
a clusterConfig.xml file.

Step 6 Save the generated answer files as follows:

• For CiscoUnified CommunicationsManager, save both theplatformConfig.xml andclusterConfig.xml
files in the UCM folder.

• For other UC applications, save the platformConfig.xml file in the relevant application folder.

Step 7 Repeat these steps for each UC application for which you want to use touchless installation.

Create Virtual Floppy Images
Use this procedure to create virtual floppy images from the answer files. You will use the virtual floppy images
in your touchless installation.

We recommend that you follow the recommended naming conventions for your .flp files.Tip
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Before you begin

1. You can use Winimage to create the virtual floppy images. You can download Winimage from
http://www.winimage.com/download.htm. You can also use other tools, such as BFI, to create virtual
floppy images.

2. Generate Answer Files, on page 18

Step 1 In Winimage, select File > New.
Step 2 From the Standard format, select 1.44 MB and click OK.
Step 3 Drag the platformConfig.xml file for the UC application onto the Winimage window.
Step 4 When prompted to inject the file into Winimage, click Yes.
Step 5 Cisco Unified Communications Manager only. Drag the clusterConfig.xml file onto the Winimage window.
Step 6 Select File > Save As.
Step 7 Save the file as a virtual floppy image (.flp file) using the following naming conventions:

• Cisco Unified Communications Manager—ucm.flp
• IM and Presence Service—imp.flp
• Cisco Unity Connection—cuc.flp
• Cisco Unified Contact Center Express—ccx.flp

Step 8 Repeat this procedure for each UC application for which you want to use touchless installation.

Upload Virtual Floppy Images to Datastore
Use this procedure to upload the virtual floppy images to the datastore.

Before you begin

Create Virtual Floppy Images

Step 1 Start the VMware Embedded Host Client.
Step 2 Select Storage.
Step 3 Right-click on a datastore and Browse the datastore.
Step 4 Navigate to the destination directory and click the Upload icon.
Step 5 Upload the vFloppy images to the AFG folder.
Step 6 At the Upload/Download warning, click Yes.
Step 7 Close the Datastore Browser window.

Mount Virtual Floppy on Virtual Machines and Set Boot Option
Use this procedure to mount the UC application virtual floppy images on their corresponding VM.
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This step is not required for predeployed VMs as they are already configured.Note

Before you begin

Upload Virtual Floppy Images to Datastore

Step 1 In the VMware Embedded Host Client, select the UC application virtual machine.
Step 2 Select Virtual Machine.
Step 3 Click Edit.
Step 4 From the Virtual Hardware tab, select Floppy drive.
Step 5 Select Use existing floppy image.
Step 6 Browse to the datastore and locate the virtual floppy image.
Step 7 Select the file and click OK.
Step 8 Under Status, enable the Connect at power on option.
Step 9 Click the VM Options tab. Under Boot Options, check the Force BIOS setup, and then click Save.
Step 10 Repeat this procedure for each UC application for which you want to perform touchless installation.

Run Touchless Installation
After you have mounted your virtual floppy drives to your application VMs, run the touchless installation
process. We recommended that you run all of your touchless installations simultaneously.

If your VM is predeployed, you need to perform step 6 only.Note

Step 1 In the VMware Embedded Host Client, right-click the VM and select the Console > Open console in new window.
A console window opens.

Step 2 Click the Power On icon in the console toolbar to power on the virtual machine.
Step 3 When the BIOS screen appears, configure the following boot order:

a) CD-ROM
b) Hard Drive
c) Removable Devices
d) Network

Step 4 Save the settings and exit the console.
The UC application installation commences immediately.

Step 5 Repeat these steps for each UC application that you want to install.
Step 6 Once the installations are complete, remove the vFloppy configurations from the virtual machines.
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Install UC Applications Manually
Use this procedure to follow the interactive install process to install any UC applications that do not have a
touchless install option such as Cisco Emergency Responder.

Step 1 In the VMware Embedded Host Client, power on the VM for the application that you want to install.
Step 2 Right-click the VM, and choose the Console > Open console in new window.

A console window appears.
Step 3 Follow the screen prompts to install the application from the console.
Step 4 If you are using the manual method to install both Cisco Unified CommunicationsManager and IM and Presence Service,

once the Cisco Unified Communications Manager publisher node installation completes, do the following:
a) From the VMware Embedded Host console, log in to the Cisco Unified Communications Manager CLI.
b) Run the set network cluster subscriber dynamic-cluster-configuration 24 command.
c) Open a VMware Embedded Host console window for the IM and Presence or subscriber virtual machine.
d) Power On the virtual machine.
e) Enter the configuration information for the application to complete the installation.

Step 5 Repeat this procedure for each UC application that you want to install.
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C H A P T E R 3
Post-Installation of the Cisco Business Edition
6000 or 7000

• Post-Installation of the Cisco Business Edition 6000/7000 appliance, on page 23

Post-Installation of the Cisco Business Edition 6000/7000
appliance

Complete the following procedure after the installation of Cisco Business Edition 6000/7000.

Step 1 Licensing Applications, on page 23

Follow these steps to perform the first-time setup and apply licenses for your UC applications.

Step 2 Install Locales or Patches for Applications, on page 23

Install new locales for your UC applications.

Licensing Applications
Refer to the technical documentation of each application you are using for license logistics. Applications ship
unlicensed. No application licenses are included with M6 appliance

Install Locales or Patches for Applications
Complete the following tasks to install locales or patches for your application VMs.

• Patches that are shipped with the appliance were current at the time of manufacture. Visit
http://software.cisco.com for more recent updates.

• For additional information on locales, refer to the Phone Locale Installers wiki at:
http://docwiki.cisco.com/wiki/Cucm-phone-locale-installers.

Note
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Procedure

PurposeCommand or Action

Associate the locale or patch installer with the appropriate
VM.

Associate Bundled Locale or Patch ISO with Virtual
Machines, on page 24

Step 1

If you want to install locales or patches for Cisco Unity
Connection, stop the services before you install the locale
or patch.

Stop Services for Unity Connection, on page 24Step 2

Install the locale or patchon the VM.Install New Locales or Patches, on page 24Step 3

Associate Bundled Locale or Patch ISO with Virtual Machines

Before you begin

Use this procedure to associate your locale or patch images with the appropriate application VM before starting
the install process.

Step 1 In the VMware Embedded Host Client, select the Virtual Machine on which you want to install a new locale or patch.
Step 2 Click Edit .
Step 3 From Virtual Hardware tab, select CD/DVD Drive.
Step 4 Select Datastore ISO File from CD/DVD Drive 1 drop-down list.
Step 5 Browse to the datastore and select the appropriate locale or patch ISO file.
Step 6 Click Select.
Step 7 In CD/DVD Drive 1, check the Connect at power on check box under the Status.
Step 8 Repeat this procedure for each VM for which you want to install a new locale or patch.

Stop Services for Unity Connection
Use this procedure if you want to install a new locale or patch for Cisco Unity Connection. You must stop
services on the Unity Connection VM before you install a new locale or patch.

Step 1 Log in to Cisco Unity Connection Serviceability.
Step 2 Choose Tools > Service Management.
Step 3 Stop the following services:

• Connection Conversation Manager
• Connection Mixer

Install New Locales or Patches
Use this procedure to install a new locale or patch for any UC applications on your Business Edition appliance.
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• For Cisco Unified Communications Manager, you must install locales or patches for the publisher
node and restart it before you install it for any subscriber nodes.

• You can install locales for Cisco Unified Communications Manager and Cisco Unity Connection
in parallel.

Note

Step 1 Log in to Cisco Unified Communications OS Administration.
Step 2 Navigate to Software Upgrades > Install/Upgrade. The Software Installation/Upgrade window displays.
Step 3 From the Source drop-down list box, choose DVD/CD.
Step 4 Click Next.
Step 5 Select the update file that you want to install and click Next.
Step 6 After the download completes, click Next.
Step 7 After the locale or patch installs, restart the appliance:

a) Log in to the VMware Embedded Host Client
b) Right-click the VM on which you installed the locale or patch and select the Guest OS > Restart

What to do next

After you install your Cisco Business Edition 6000/7000 appliance, you can provision users, devices and
configure features on the system. Refer to the administration guides of the applications you installed.
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A P P E N D I X A
BE6000 Supported Solution Capacities

• BE6000 Supported Solution Capacities, on page 27

BE6000 Supported Solution Capacities
This section presents some of the supported deployment limits for the coresident applications on Cisco Business
Edition 6000. It is important to stay within these limits while planning system utilization to avoid
oversubscribing an appliance.These limits to not apply to deployments running on BE7000 appliances or other
non-BE6000-appliance hardware.

Performance Limits on BE6000Application

• 150 Users / 300 Endpoints for BE6000S.

• 1000 Users / 1200 Endpoints for BE6000M

• 1000 Users / 2500 Endpoints for BE6000H.

• Total 50 CUCM Locations / Gateways / Sites

• 50 Extension Mobility login or logout every hour.

• 50 Music On Hold sessions/calls.

• 20 Software Conferences

• 250 CTI endpoints

• 150 Presence enabled Users for BE6000S

• 1000 Presence enabled Users for BE6000M or
BE6000H

• LDAP Authentication and Synchronization

• Clustering & Redundancy

• Overall BHCA 5000

Unified Communications Manager
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Performance Limits on BE6000Application

• 1000 Users / 1000 Voicemail boxes for BE6000M.

• 24 Voicemail ports with maximum 6 VUI ports, @
1000 BHCA

• 500 IMAP sessions

• 150 CPCA sessions

Cisco Unity Connection

• 1000 Users for BE6000M

• XMPP Load

• 20 IM per user per hour

• 2 State changes per user per hour

• 20 contacts per user

Unified Communications Manager – Instant
Messaging & Presence Service

• 100Agents@15BHCAper Agent (BE6000Monly)

• 10 Recording Sessions

• 100 IVR Sessions

• Periodic Historical reporting

For more details, see Cisco Unified Contact Center
Express Design Guides.

Unified Contact Center Express/IP IVR

For more details, see datasheets.Cisco Emergency Responder

• Up to 50 operators

• Up to 100 queues

• Different music in different queues

Comparison between various CUxAC editions.

Cisco Unified Attendant Console

• 100 Traversal and non-traversal calls

• Up to 30 MCUs

For more details, refer to Cisco Expressway
documentation.

Cisco Expressway with registrations

For 10HD ports per VMCisco TelePresence Server Virtual Machine

• 1000 Users

• Pre-recorded / schedule broadcast

• Notification

• 911/emergency call monitoring / alerting / recording

• Weather Alerting

• 50 Users per paging group

Cisco Paging Server
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Performance Limits on BE6000Application

• 1000 Users on BE6000M

• 150 phones or voice terminals on BE6000S

• 1200 phones or voice terminals on BE6000M

Cisco Prime Collaboration Provisioning
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A P P E N D I X B
Cisco Smart Licensing for CUCM 12.5 and 14
BE6000-specific Licenses

• Cisco Smart Licensing for Unified Communications Manager 12.5 and 14 BE6000-specific Licenses,
on page 31

Cisco Smart Licensing for Unified Communications Manager
12.5 and 14 BE6000-specific Licenses

For a general overview of Cisco Smart Licensing, and how it is used in conjunction with Unified
Communications Manager 12.0 and higher, see the Cisco Smart Software Licensing with Cisco Unified
Communications Manager Solution Overview.

The instructions in this appendix only apply if you have purchased BE6000-specific UCL and UWL 12.5
starter packs and add on user licenses. These licenses are described in the Business Edition 6000 Ordering
Guide available to partners and Cisco employees.

• If you are using a different license offer or are using version 14 licenses (which are only sold as
Collaboration Flex Plan) (such as non-BE6000-specific UCL, UWL, Enterprise Agreement or
Collaboration Flex Plan), stop now and see the Cisco Smart Software Licensing with Cisco Unified
Communications Manager Solution Overview for instructions.

• Smart Licensing for BE6000-specific licenses are only available for Collaboration System Release from
12.5 and above.

• Unified Communications Manager 12.5 in BE6000-specific licensing requires use of Cisco Smart
Licensing, and for the UCM 12.5 Publisher to have 'BE6000 mode' enabled using the CLI.

• You must create a Cisco Smart Account (this can be done prior to installation). You must deposit the
newly purchased BE6000 12.5 licenses in this account. Installed base customers must migrate licenses
to 12.5 and deposit in this account.

1. Obtain your BE6000-specific 12.5 licenses. These instructions assume that you have already completed
the required purchase/fulfillment processes. Partners and Cisco employees may consult the Business
Edition 6000 12.5 Ordering Guide.

2. Provision your Smart Account / Virtual Account in Cisco Smart Software Manager; ensure that your
BE6000-specific licenses are assigned to your Smart Account / Virtual Account.
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For more information, see the Cisco Smart Software Licensing with Cisco Unified Communications
Manager Solution Overview.

Ensure that your BE6000-specific licenses for starter packs and add-on users are properly assigned to
your Smart Account / Virtual Account.

See the following screenshot of Cisco Smart SoftwareManager showing a Smart Account/Virtual Account
that has BE6000 12.5 specific and starter pack licenses assigned to it:

3. Obtain a Registration Token for Unified Communications Manager 12.5 from Cisco Smart Software
Manager.

For more information, see the Cisco Smart Software Licensing with Cisco Unified Communications
Manager Solution Overview.

See the following screenshot of where the Registration Token is copied or downloaded from (you will
need this in step 6):
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4. Install Unified Communications Manager 12.5 (or version-upgrade Unified Communications Manager
from an older release to 12.5).

When Unified Communications Manager in BE6000 is initially installed as 12.5, or version-upgraded
from an older release to 12.5, Unified Communications Manager 12.5 immediately enters the following
modes:

• Registration Status 'Unregistered'.

• License Authorization Status 'Evaluation Mode'. Unified Communications Manager 12.5 remains in
'Evaluation Mode' for either 90 days, or until it is registered with Cisco Smart Software Manager
(whichever comes first).

• Licensing Mode 'Enterprise'.

The following is a screenshot of what the initial mode settings look like immediately after you install of
Unified Communications Manager 12.5 and configured devices in it:

If 'EvaluationMode' ends after 90 days without registration, then Unified Communications Manager 12.5
enters 'Enforced Mode', and administrative changes are disabled.

After registration, Unified Communications Manager 12.5 periodically syncs with Cisco Smart Software
Manager (CSSM) to verify authorization status of Unified Communications Manager 12.5 and validates
the customer’s registered licenses with locally consumed or used licenses for this Unified Communications
Manager 12.5 cluster. If CSSM reports 'Authorization Expired' or insufficient quantity of registered
licenses vs. consumed/used licenses, then, Unified Communications Manager 12.5 enters 'Out of
Compliance' status. You have an overage period of 90 days to bring licensing back into compliance, at
the end of which Unified Communications Manager 12.5 enters 'Enforced Mode', and administrative
changes are disabled.

For more information, see the Cisco Smart Software Licensing with Cisco Unified Communications
Manager Solution Overview.

5. Set the Unified Communications Manager 12.5 cluster to 'BE6000 mode' and specify which BE6000
starter pack you want to use.

On the Unified Communications Manager 12.5 Publisher node, run the platform command line interface
utils BE6000Mode enable and specify which BE6000 starter pack license you use for your install of or
version-upgrade to 12.5:

• BE6000 UCL Starter Bundle (for UCL Enhanced + voicemail)
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• BE6000 UWL Starter Bundle (for UWL Standard)

• NONE

The following is a screenshot of the command line to use:

As an example, see the following screenshot about what Unified Communications Manager 12.5 displays
immediately after being placed into 'BE6000 mode' with 'BE6000 UCL starter bundle' (shows consuming
or using one unit that has not yet been requested from registered licenses in Cisco Smart SoftwareManager):

6. Register the BE6000 Unified Communications Manager 12.5 with Cisco Smart Software Manager, using
the Registration Token.

For more information, see Cisco Smart Software Licensing with Cisco Unified Communications Manager
Solution Overview.

Enter the Registration Token obtained in Step 3 on the Unified Communications Manager 12.5 Publisher.
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The Unified Communications Manager 12.5 Publisher then attempts to request and consume or use a
single BE6000 Starter Bundle from your registered license inventory on Cisco Smart Software Manager.
The starter bundle feature-level requested is the one you specified at the time of running the platform
command line interface utils BE6000Mode enable. A Unified Communications Manager 12.5 cluster
with its Publisher in 'BE6000 mode' may only request and consume or use a single BE6000 starter pack
license. The cluster may request and consume or use any number of BE6000-specific or
non-BE6000-specific addon user licenses, subject to capacity limits of BE6000 solutions.

As an example, for a successfully registered and authorized Unified Communications Manager 12.5 in
'BE6000 mode' using a BE6000 UCL starter pack, see the following screenshots of what you would see
on the Unified CommunicationsManager 12.5 Publisher and on Cisco Smart SoftwareManager (showing
consuming or using one unit that is authorized and registered):

Unified Communications Manager:

Cisco Smart Software Manager:
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Starter Bundle License Consumption

The following is a screenshot of what the initial mode settings look like immediately once you install Unified
Communications Manager, after customer configuring the devices in 12.5:

When the user runs utils BE6000Mode enable and select BE6000 UCL Starter Bundle

The following image shows the change in the License consumption for the above selection:
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When the user runs utils BE6000Mode enable and select BE6000 UWL Starter Bundle

The following image shows the change in the License consumption for the above selection:

When the user runs utils BE6000Mode enable and select None
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The following image shows the change in the License consumption for the above selection:

Addon User License Consumption

In BE6000 mode, Unified Communications Manager 12.5 consumes BE6000 Starter Bundle addons along
with Enterprise addons.
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A P P E N D I X C
Rebuilding a Business Edition 6000 or 7000
Appliance

• Hardware and Virtualization Software Reinstall, on page 39

Hardware and Virtualization Software Reinstall
To setup hardware, follow the instructions in the install guide for the leveraged base server:

BE6000: Cisco UCS C220 M6 Server Installation and Service Guide

BE7000: Cisco UCS C240 M6 Server Installation and Service Guide

Note the following appliance characteristics:

• BE6000/7000 M6 appliances do not ship with Cable Management Arms, only Rack-mounting Kits.

• BE6000M (M6) appliance does not ship with any NICs, only motherboard LoM ports.

• BE7000M/H (M6) appliances ship with motherboard LoM ports as well as dual NICs (each quad
10-Gigabit-Ethernet copper).

• BE6000/7000 M6 appliances ship with latest firmware at time of factory build that is compatible with
ESXi 7.0 U1. At install time, there may be newer firmware available that you can freshen the appliance
to.

• BE6000M (M6) appliance requires single virtual drive, RAID5, physical disks 1-6.

• BE7000M (M6) appliance requires four virtual drives, each RAID5 with 4 physical disks.

• BE7000H (M6) appliance requires four virtual drives, each RAID5 with 6 physical disks.

• BE6000/7000 M6 appliances require virtual drives to be configured as:

• Access Policy Read Write

• Read Policy Always Read Ahead

• Cache policy as Cached IO

• Disk Cache policy as Enabled

• Write policy as Write Back Good BBU
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• The first virtual drive is set as the Boot Drive.

To install and setup VMware vSphere ESXi:

• Identify an ESXi version that is compatible with the appliance (minimum is ESX 7.0 U1) as well as the
application versions you are running.

• Locate the Cisco UCS-specific installer image for ESXi, or contact TAC for assistance. BE6000/7000
use the same ESXi installer images as UCS C220 M6S / C240 M6SX.

• ESXi must be installed to the first virtual drive (configured as the Boot Drive).

• Other ESXi settings can be found at https://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/uc_
system/virtualization/cisco-collaboration-infrastructure.html .

• Apply your license for VMware vSphere ESXi. A license is required, but not included with the appliance.

After hardware setup and ESXi setup, follow steps in Set Up Your Appliance, on page 5 to complete the
appliance rebuild.
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